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Main Meeting, June 3rd, Sunday
Bob Dickson, one of our SIG Leaders, will present information on Microsoft's "Access" Database Management System.
Access is a part of the Office suite of applications, possibly the least well known "app". Not an earth-shaker of a project, but
more of an introduction to the product, and one that was used in Bob's SIG to handle a real project. Let's hope we can all
follow along on our laptops.

Big prizes for our June raffles:
Paid drawing:
Canon Pixma iP2702 inkjet printer
Pny 32GB USB Flash Drive
TDK DVD+R 75 PAQ
HP CD_R 52x 50pk
LED Keychain

Members drawing:
Pny 32GB USB Flash Drive
SUMA Car 6in1 MP3 Player/FM X-mtr.
TDK DVD+R 75 PAQ
10-in-1 Pliers/Multi-Tool
LED Keychain

June winners’pix (Click Here). Yes Consignment Table and E-Waste Collection in June.

Special Interest Groups (SIGs) & Main Meeting
9:00 a.m.
Linux for Desktop Users
………....................Science 131
Topics about the Linux operating system.
Beginner’s Qs here.
Visual Programming .. ……………………..
….Science 111
Visual Basic, Visual BasicScript, Visual C++ and
Visual J++.
Laptops, Smartphones, & Social Media
......Science 109
Social Networking & any computer-related
topics you want to discuss.
Beginners Digital Photography
……..........Science 131A
Topics about digital photography.
Microsoft Word, Excel, and Outlook…….…
Science 306

10:30 a.m.
Advanced Digital Photography………………..Science 131A
Demonstrations of a variety of useful photographic tools/accessories and the Canon S100 camera
.
Understanding Operating Systems…………....Science 111
Help with DOS, Windows, OS/2, etc.
Mobile Computing.... ……..................................Science 109
This SIG discusses mobile devices.

12:00 Noon
PIG SIG………………………….………..Hashinger Courtyard
Microsoft Access ………….....................…….…Science 306
Database applications and more.

12:30 p.m.

Advanced PC Q & A…………………….......…….…Irvine Hall
Three parts of the Microsoft Office Suite plus Open PC hardware & software topics and the Internet. Members Q & A
each other.
Office.
Reviews & Consignment Tables, Coffee & Donuts:
Irvine Hall Lobby

10:30 a.m.
Beginners PC Q & A ......................................
Irvine Hall
Building your own PC and other topics!
Linux
Administration………………...............Science
131
More topics about the Linux operating system.
Access/Excel VBA……………………….……
Science 306
Access & Excel VBA code.
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2:00 p.m. Main Meeting…….…..Irvine Hall

Bob Dickson is scheduled to do the 2 PM presentation June 3rd,
2012.

Firm Future Meeting Dates in 2012 and 2013:
July 15th - 3rd Sunday, August 12th - 2nd Sunday, September
2nd, October 14th - 2nd Sunday, November 4th, December 2nd,
January 6th, 2013, February 3rd, 2013, March 3rd, 2013, April
7th, 2013, May 5th, 2013.
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Orange Bytes Staff

Publication Chairman - Oversees publication tasks and converts the Orange Bytes newsletter
to PDF for archiving and web posting; transmits PDF to Printer.
Open...................................................................................................editor@noccc.org
Editor - Edits, composes, and makes final selections of the articles in the newsletter.
Rudy Lauterbach......................................714-529-5730..................... editor@noccc.org

Calendar of Meetings
Table of Contents
President's Message
NOCCC Elections
Membership Benefits
Main Meeting Report
Raffle Winners
Consignment Table
Officers & Club Volunteers
Help Line Volunteers
Sig Leaders
Computer Talk
Product & Book Reviews
SIG Meetings Reports
Free Ad Space
Parking & Travel
Board Meeting Minutes
NOCCC Bylaws
Past Issues of Orange Bytes
Fee Schedule
Pig SIG
Links to Other Clubs
Browser Notes
End Notes

Associate Editor/Production - Receives articles from the editor and proofreads newsletter.
open...................................................................................................... editor@noccc.org
Circulation - Oversees mailing and distribution of the newsletter.
Richard Miller............................................(714) 309-1504................. rrrmil@gmail.com.
Reviews Editor - Communicates with the vendors and members who evaluate products and
write reviews. Makes sure members meet deadlines. Sends a copy of the newsletter to vendors
of products we review.
open..................................................................................................... reviews@noccc.org
Copy Editor - Does final proof reading of the newsletter for typos and misspellings.
Dennis Martin…………............…. (951) 926-3065.... dennismartin@dslextreme.com
VOLUNTEERS NEEDED
The following positions are available:
Publication Chairman - Distribute printed version of the Newsletter - Assistance with
content preparation is needed.
Social Media Contacts – Maintain and write articles for the newsletter.
Contributing Editors - Write articles for the newsletter.
Commercial Advertising - Obtains ads from vendors for the newsletter.
Classified Advertising - Obtains computer-related, non-commercial ads for the newsletter
free to NOCCC members

Celebrating 36 years of
"Friends Helping Friends"
President’s Message
For June 2012
by Dr. Patricia Adelekan, DTM, CTA
North Orange County Computer Club (NOCCC)
As I write my first “Message from the President,” I feel quite honored to serve as the 2011-2012
President of the North Orange County Computer Club (NOCCC) – an organization known for its
pioneer efforts, many accomplishments, award-winning Orange Bytes Newsletter, dedicated
members, and “Friends Helping Friends” -- a legacy to last forever.
I have given much thought about what to say, as a new comer on the block. First, yes it is an honor. I joined NOCCC in April 2011-ready for whatever the club might offer, and for however I might serve. Since that time, I have served on the Board of Directors and
lead a Special Interest Group (SIG) dealing with smartphones (computers), social media and modern technology. Both positions have
been exciting, interesting and I have been able to learn a lot from members and tech-savvy expert guest speakers who often present
during my SIG, and at the Main Meeting.
As the new President, I recall the words of Robert Frost, who once wrote “ Don’t even take a fence down until you know why it was
put up.” Thus, with my research background, I decided to gather information: to talk to the Board Members, past members, Chapman
University personnel, Jim Peugh, and others having experience with NOCCC. I wanted to know more about the history and
accomplishments of NOCCC.
What a marvelous journey it is turning out to be – Everyone (especially each new Board member) has been helpful and
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accommodating in answering questions I pose. Jim Sanders, immediate Past President, let me borrow initial copies of the Orange
Bytes newsletter dating back to 1976. John Heenan, Treasurer, provided me a with list of the first 117 people who signed up for the
organization. And, still there remains others I expect to interview. In this effort of “finding out” I request your patience as I learn
more about NOCCC and its history--and about the hopes, dreams and concerns as current active members, staff, SIG leaders,
volunteers, and the public.
As a result of “knowing more,” many of us have agreed that NOCCC has endured so long because it has always been on the cutting
edge of technology and because of its dedicated and concerned computer-minded individuals who encouraged and believed in
exchanging and sharing information in a positive and supportive environment with the motto: "Friends Helping Friends." Even those
who came along since then also adopted the slogan and mission of the club thus sustaining it ( NOCCC) over the years.
It has been strongly expressed by the Board of Directors that we (the members, Board of Directors,SIG leaders and all other entities)
work together to increase our dwindling membership (encouraging multi-generational activities and collaborations) to have at least
100 attendees at the monthly Main Meeting, and at least 10 persons in each SIG –all held generally on the first Sunday of the month.
We together can realize this DREAM if each NOCCC member, Board of Directors members, SIG leaders, volunteers and friends of
the organization work hand-in-hand to rebuild and rekindle the burning desire for people to join North Orange County Computer
Club. Many of us have plans and suggestions which need to be discussed and decided. I will be reporting on the progress of the
"Rebuilding Goals" in each issue of the Orange Bytes as part of my "President's Message.”
In order to start on our “Membership Building Plan” for 2011-2012, there will be a Special Meeting of the Board of Directors, on
Wednesday, June 27, 2012 from 6:00 pm. To 9:00 p.m. at my home (the new monthly Executive Meeting venue), 891 S. State
College Blvd, Anaheim, Ca 92806 (across from Boysen Park on the corner of Vermont and State College Blvd). The meeting is open
to all members. I encourage all members, friends, SIG leaders, Board of Directors and other interested parties to submit your ideas
and concerns to me before the June 27, 2012 meeting. And I will get back with you before the meeting for any questions you or I may
have and to let you know if your item will be on the agenda at the Special Executive Board meeting. Again, we welcome all
interested parties to attend the meeting.
I pledge with this first “Message from the President,” to serve the NOCCC and to uphold its purpose and mission – to cultivate
community interest in computers and computing, and to promote and encourage cooperation and exchange of information with the
public through the activities of the corporation—as stated in the Articles of Incorporation filed with the State of California on March
29, 1984.
I also personally will head the committee responsible for coordinating "Programs & Speakers." My goal is to secure high-quality
technical experts to be speakers at our Main Meetings. And, I eagerly welcome suggestestions about topics, themes, issues and
speakers from members and non-members alike.
Finally, and most importantly, as a result of serving on the Board and observing the dedication and commitment of so many, I have
proposed starting off the New Year, at the July 15, 2012, meeting with a Recognition and Appreciation Reception at which many past
contributing members, SIG leaders, Chapman University personnel, E-waste owners, volunteers, and others might be presented with
Certificates of Appreciation—and, possibly other awards. This event is to take place on Sunday, July 15, 2012, during the Main
Meeting at Hashinger Auditorium (at Chapman University, Orange, Ca.) from 2-4p.m. All members are encouraged to invite their
family and friends - and potential new members – and the media. Refreshments will be served. At the end of the Appreciation
Ceremony, there will be a Formal Induction of the new members of the Board of Directors.
During the reception there will be speeches about the history and stories of the NOCCC -- since its beginning. We shall have lots of
fun. Do please bring your cameras, smartphones, ipads, and other tech tools. Also, please submit to the Vice President, Dr. Don
Armstrong, the names of any persons, organization, or entity you feel deserve to receive a Certificate of Recognition and
Appreciation from us.
Until we meet again,
Dr. Patricia Adelekan, DTM, CTA
President, NOCCC 2012-2013
P.S. Perhaps we might go back to some of the “Best Practices” of NOCCC in the past. More talk about that later. I sincerely welcome
constructive input, ideas, suggestions and volunteers from members as well as non-members.

NOCCC Elections at the June 2012 Main Meeting
Elections were held at the June 3rd main meeting.
The current Officer Corps and Board of Directors is shown below.
While mostly taken from the Bylaws, the summary of duties below is nearly all-inclusive.

Current Complement of NOCCC Officials
President:
Dr. Patricia Adelekan
Vice President: Dr. Don Armstrong
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Treasurer:
John Heenan
Secretary:         Steven Breitbart
Director:
Director:
Director:
Director:
Director:
Director:
Director:
Director:
Director:

Jim Sanders
Gordon E. Strickland Jr.
Richard Miller
Gerry Resch
Ben Lochtenbergh
Dallas Hazleton
Tia Christian
Larry Klees
Rudy Lauterbach (Newsletter)

    President and Vice President

NOCCC Executive Board Descriptions
“The NOCCC Executive Board “subject to the limitations of those bylaws, shall debate, establish, amend, and update the policies for
all the affairs and business of the NOCCC.”
“The Board shall concern itself with the disbursement of all NOCCC moneys. The Board shall consider the budget and such
additional expenditure requests as are submitted by the president, and shall authorize such expenditures as it considers wise and
appropriate.” The NOCCC Executive Board consists of four officers, eight elected directors, and ex-officio members. There are four
officers of the club: President, Vice-President, Secretary, and Treasurer.
Duties of the President

Represent the NOCCC to the community as the chief executive officer.
Set the agenda for and presides at all general meetings of the club.
Set the agenda for and presides at all meetings of the NOCCC Executive Board.
Appoint members to chair all standing and special committees and appointed positions.
Receive, on behalf of the NOCCC, all contributions to the club.
Duties of the Vice President

Assume special duties as may be directed by the president.
Duties of the Secretary

Establish and maintain a record of all NOCCC correspondence, and attend to correspondence as directed by the president of the
Executive Board.
Duties of the Treasurer

Receive and deposit into the NOCCC accounts all moneys received.
Establish and maintain a record of all real or personal property acquired by the NOCCC and cause said property to be permanently
identified as property of the NOCCC.
Suggest, if appropriate, to the Executive Board that an audit be made and reported to the general membership.
Elected Directors
The eight elected directors are on the Executive Board and, along with the four officers, address any issue that comes before the Board.
Ex-officio members of the Executive Board
Ex-officio members of the Executive Board are the immediate past president, editor of the club newsletter and the webmaster. The President
appoints the editor and webmaster.
Other Appointed Positions
These positions are Membership Chairman, Reviews Editor, Public Relations, Business Solicitations/Lecture Series, Classified Advertising
for Members, Commercial Advertising, Webmaster and Programs/Speakers Coordinator. Contact the current club President if you are
interested in any of these positions. We can then include your name in the next issue of the Orange Bytes.

Membership Benefits
As a valued member, we bring you a section of discounts and offers as part of the entire “Benefit of Belonging.” (Caveat: we are
unable to endorse these companies, but make these offers available as a service to our members.)

User Group Offers - Software and Hardware

User Group Relations – You can now order the latest release of Acronis True Image 2012 for only $25 (download) or $25 plus
S&H (on a CD). This top-rated backup utility has many new features and will work with Windows 7. Use the following link for
special pricing for user group members: Acronis.
Techsmith You can get SnagIt 11, an outstanding screen capture program, and Camtasia Studio 7, to quickly record, edit and
publish multimedia demos and presentations, bundle for $269, an $81 savings: https://store.techsmith.com/government.asp. You
can download SnagIt 10 alone for $42.95.
Books and Magazines -Pearson Education Products - including Prentice Hall Professional, Addison-Wesley Professional, IBM Press, Exam Cram, Que
Publishing, and Cisco Press. Get 35% off list price by purchasing directly from the publisher combo site: www.informit.com/>
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Sign in or create an account. Enter the membership code “USERGROUP” (all caps). Select your items and check out. You are
required to register and apply the code once, but you must be logged in to receive the special pricing.
O’Reilly Books 40% off all books and videos from O’Reilly, Microsoft Press, Pragmatic Bookshelf, and SitePoint, or 50 % off
books you purchase directly from O’Reilly. Just use code DSUG when ordering online, www.oreilly.com/store/, or by phone,
(800) 998-9938. Free ground shipping on orders $29.95 or more in the US. If for any reason you are not completely satisfied with
your purchase, you can return it to O’Reilly and get your money back; see www.oreilly.com/oreilly/cs/guarantee. A return
shipping label is included with every direct purchase and directions are posted online in case you misplace it.
Peachpit Press Books Discount - Get 35% off by joining the Peachpit Club. Use the following hyperlink to sign up:
http://memberservices.informit.com/my_account/login.aspx?partner=52 to sign up as a member. User group members should note
that once you have become a Peachpit Club member, you might use your user group coupon code ON TOP of the permanent
savings you earn as a member of the club. Just log into the site before you make a purchase to ensure this permanent discount will
be in effect, and then enter coupon code UE-23AA-PEUF (case-sensitive) at checkout! This coupon code is an exclusive offer
that may not be used in conjunction with any other coupon codes. The offer applies to all titles at peachpit.com including New
Riders, Macromedia Press, Adobe Press, and Peachpit.
Free Internet Libraries - Upon retiring from college teaching/administration, Walter Antoniotti began developing Free Internet
Libraries for students, teachers, and professionals. http://www.businessbookmall.com/Free Internet Libraries.htm. Of special
interest to PC users are these free computer libraries: Free Business Software: Business Software Internet Library.htm
Free Software Tutorials: http://www.businessbookmall.com/Software Tutorials Internet Library.htm
Excel Internet Library: http://www.businessbookmall.com/Microsoft _Excel_Directions_For_Beginners.htm

June 3rd, 2012 - Main Meeting Report
By Steven Breitbart, NOCCC, Secretary
Club Business
President Jim Sanders opened the meeting and introduced Rudy Lauterbach, our Webmaster. He also announced that John Klees
volunteered to be on the board as a Director. As a result, the club has a full slate of Officers, Directors, and Editor.
President-elect Dr. Pat Adelekan also had a few encouraging words. We still need more volunteers. Richard Miller spoke about
the Book Review table. Jim elaborated saying that there are three parts to the Book Reviews. One is giving out the book or
software at the table with the understanding a review is due is two or sometimes three months. At this point, a credit card number
or check is left as a deposit. Another part is tracking who has what book or software and what is the status of their review. Third
is contacting publishers of books and software to see if they will give us samples to review. In return for a completed review, the
reviewer can keep the book or software.
Main Speaker
Jim introduced Bob Dickson who is the leader of the Microsoft Access/Excel Visual Basic for Applications (VBA) and Access
special interest groups (SIGs). Bob said that while Excel is great for keeping many types of lists, it’s not good for everything. For
example, if you want a photo of each item listed or you wanted an easy form to input data on each item, Access may be better
than Excel. Access is a relational database and has a lot of capabilities. Many templates are available and make creating a data
base relatively easy. Bob started by showing us an Access table; one of many views you can get of your data. It was easy for him
to add or remove fields.
Over the last several months Bob has been working with NOCCC member Helen Phillips to catalog her collection of quilts using
an Access data base. They set up a data base with a record for each quilt. Each record contains data about the quilt such as size
and shape. Each record had a photo that Helen took using a digital camera. The data base was set up so records of 4 quilts could
be printed on one page.
Another data base was created for Helen’s collection of dolls. They set up a user form used to fill in data about each item, in this
case dolls. Helen’s participation in NOCCC (SIGs) has made her work possible. She has learned from the Access SIGs as well as
the Digital Photography SIGs.
A raffle was held and the following prizes were awarded. See photos below.
General Raffle Winners
NAME
PRIZE
Dallas Hazelton
printer
Dennis Martin
pack of DVDs
Robert van Horn
pack of DVDs
Bill van Horn
Paragon software
Pat Adelekan
LED keychain
Gerry Resch
PNY thumb drive
Members-Only Raffle Winners:
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Don Armstrong
Bob Dickson
Terry Dickson
Pat Adelekan
Martin LaRocque
Robert van Horn
Dallas Hazelton

Paragon software
PNY thumb drive
MP3 player
Audio connects kit
pack of DVDs
LED keychain
multi-tool (looks like pliers)

Another interesting meeting. See you next month.
Steven M. Breitbart, P.E.
h) (714) 486-3070
c) (714) 421-1118

THE June 2012 MEETING RAFFLE WINNERS

Dallas Hazelton

Dennis Martin

Robert van Horn

Bill van Horn

Don Armstrong

Bob Dickson

Terry Dickson

Pat Adelekan

Dallas Hazelton

Pat Adelekan

Martin LaRocque

Robert VanHorn

Gerry Resch
Photos by John Krill

The prizes shown are one of the following:
Canon Pixma iP2702 inkjet printer, Pny 32GB USB Flash Drive, TDK DVD+R 75 PAQ,
HP CD_R 52x 50pk, LED Keychain. (When you buy mass quantities of tickets, you may win twice.)

PREVIOUS RAFFLE WINNERS
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John Krill

Gordon Strickland

Dennis Martin

Jim Sanders

Gordon Strickland

Ron Hallet

Dallas Hazelton

Steven Breitbart
Photos by John Krill

The prizes shown are one of the following:
Speakers, System Utilities software, LED Key Ring Light, Web Easy 8 software, PC Tools software, Quicken software,
and Clip Light.

PREVIOUS RAFFLE WINNERS

Bob Dickson

Carl Rau

Don Armstrong

Gordon Strickland

Jim Sanders

John DeCarlson

Martin LaRocque

Rudy Lauterbach

Steven Breitbart

Vince Lazore
Photos by John Krill

The prizes shown are one of the following:
Canon Pixma iP2702 inkjet photo printer, Logitech wireless keyboard, Patriot memory 16GB USB flash drive,
or a Targus Stylus for phones and tablets.
(Eventually we'll get every member's picture up here, for recognition purposes.)

GENERAL DRAWING PRIZES *: Selected each week by the President.
* Parking stubs are good for two raffle tickets each!
See the article immediately below this list!
MEMBERS-ONLY DRAWING PRIZES
(Wear your NOCCC Badge and get a free ticket!)
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Save Your Parking Permits!
To offset the cost of parking in the Lastinger Underground Parking Structure, the NOCCC Board approved a motion to
give each member two NOCCC General Drawing raffle tickets in exchange for the Lastinger-parking permit. Turn the bottom-half
“receipt” part of your permit to the Rafflemeister on the same day or hold it until the next meeting. Gerry Resch, the Raffle
Leader, will exchange it for two raffle tickets.
The reason for this is that the NOCCC Board has found that some people are not attending meetings or not renewing their
memberships because of the parking situation. Chapman University has allowed us to park in the Lastinger Parking Structure
under Wilson Field for only $2 for the whole day of our meeting; normally $2 is good for only two hours. The advantages of
parking there are clear; you don’t have to drive around looking for a legal spot (remember, don’t park on the private home side of
the street), the car doesn’t get hot and you don’t have to parallel park. There is even an elevator available to get down to the
parking area.

Consignment
The NOCCC Consignment Table in the lobby of Irvine Hall will be available during the June 2012 meeting. It is open on even months,
the same as the E-Waste collection.
Consignment Table Rules - coming soon.
E-waste Collection Rules
California disposal laws have made it illegal to put monitors and computers in the regular trash. Omni Technics, Inc. will be
at our regular meetings to collect E-Waste on even months , so save your “junk until April.
Check their web site for more information: http://www.ca-recycle.com /. Or, call (562) 627-1910.

NOCCC Officers and Club Volunteers
Officers: As of 6/3/2012.
The area code for the following phone numbers is 714 unless noted.
President
p_adelekan@yahoo.com
Dr. Patricia Adelekan
628-9844
Vice President
Dr. Don Armstrong
773-1187
docarmstrong@gmail.com
Secretary
Steven Breitbart
486-3070
sbreitbart@socal.rr.c
Treasurer
John Heenan
998-7660
treasurer@noccc.org
Directors
Dallas Hazleton
526-1592
ghazleton4@dslextreme.com
Ben Lochtenbergh

(949) 653-2545

bal@msn.com

Richard Miller

309-1504

rrrmil@gmail.com

Gerry Resch

772-6667

gerry@gerryresch.com

Gordon E. Strickland, Jr

970-7730

gestrickland@earthlink.net

Tia Christian

263-6105

Iwilliams_00@yahoo.com

Larry Klees

879-7962

larryklees@yahoo.com

Jim Sanders
Editor
Rudy Lauterbach

544-3589

jsanders@ligasmicro.com

529-5730

editor@noccc.org

For any email communication to Officers, Board, or Editor, please include "NOCCC" in subject.

Volunteers, Committees, and Projects
We have numerous interesting assignments available. As an all-volunteer organization, you can join with other members in
a variety of activities: solicit newsletter ads, write articles for our newsletter, conduct a seminar, run a SIG, give a Main
Meeting presentation, show new members around, join a committee, assist in setting up the meeting or participate in computerrelated community volunteer work. Become an NOCCC member by signing up at the Reviews/Membership Desk during a

file:///D|/work/noccc/rl-www/htdocs/orangeBytes.html[7/1/2012 5:51:47 PM]

NOCCC / OrangeBytes

general meeting, usually the first Sunday of the month.
Consignment Table
Richard Miller

309-1504

rrrmil@gmail.com

772-6667

gerry@gerryresch.com

Raffle Leader
Gerry Resch

Helpline
Membership Database

Open

John Heenan

998-7660

treasurer@noccc.org

(949) 653-254

bal@msn.com

526-1592

ghazleton4@dslextreme.com

Membership Chairman
Ben Lochtenbergh

SIG Coordinator
Dallas Hazleton

Programs/Speakers Coordinator
628-9844

Dr. Patricia Adelekan

Public Relations

p_adelekan@yahoo.com
Open

University Liaison
Dr. Patricia Adelekan

628-9844

president@noccc.org

529-5730

rblauter@cs.com

Webmaster
Rudy Lauterbach

Chapman U. Campus Security 997-6763 open locked rooms, problems

NOCCC Help LineVolunteers
The Help Line is in the true spirit of the NOCCC, which is to help others to learn more about computers. The following is a list of
Help Line subjects that a NOCCC volunteer is able to help you deal with. Most volunteers prefer being contacted by e-mail.
Mention NOCCC in the Subject line.
Apple II Gerry Resch 714-772-6667

gerry@gerryresch.com

Corel Draw Larry Klees 714-879-7962

larryklees@yahoo.com

Digital Photography Larry Klees 714-879-7962

larryklees@yahoo.com

Excel Gerry Resch 714-772-6667

gerry@gerryresch.com

GPS Navigation Bob DeWolf 714-879-8269

rsdewolf@adelphia.net

Linux Bob Ray 714-634-7520

bobsdesk@dialup4less.com

Lotus 1-2-3 Gerry Resch 714-772-6667

gerry@gerryresch.com

Microsoft Office John Heenan 714-998-7660

heenanjc@sbcglobal.net

PC Hardware Jim Sanders 714-544-3589

jsanders@ligasmicro.com

Photo editing & Pshop Larry Klees 714-879-7962

larryklees@yahoo.com

QuickBooks - all ver. Linda Russell 909-949-4930

qbqueen@verizon.net

Tcl/Tk & UNIX Bob DeWolf 714-879-8269

rsdewolf@adelphia.net

Windows 7, Vista & XP Jim Sanders 714-544-3589

jsanders@ligasmicro.com

Windows 9X & XP John Heenan 714-998-7660

heenanjc@sbcglobal.net

WiFi & Networking Jim Sanders 714-544-3589

jsanders@ligasmicro.com

Do you want to be an NOCCC Help Volunteer and assist other members with computing subjects
that you know well? If so, please contact one of the directors.

SIG Leaders
Contact the SIG leaders by e-mail, preferably, rather than by telephone.
SIG

Bldg
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Linux for Desktop/Admin

Science

13

9:00/10:30

Bob Ray

bobrobo@dialup4less.com

(714) 634-7520

Beginner’s Digital Photog.

Science

127

9:00

John Krill

noccc.bgphotosig@gmail.com

(949) 497-8658

Visual Programming

Science

111

9:00

Anson Chapman

aec@cclift.com

(909) 860-9515

Laptops & Social Media

Science

109

9:00

Dr. Patricia Adelekan

p_adelekan@yahoo.com

(714) 628-9844

Word, Excel, & Outlook

Science

306

10:30

Tia Christian

Iwilliams_00@yahoo.com

(714) 263-6105

Mobile Computing

Science

109

10:30

Ben Lochtenbergh

bal@msn.com

(949) 653-2545

Access/Excel VBA

Science

306

10:30

Bob Dickson

robertbdickson@socal.rr.com

(714) 539-1304

Advanced Digital Photography

Science

127

10:30

Larry Klees

larryklees@yahoo.com

(714) 879-7962

Understanding OS’s

Science

111

10:30

Charlie Moore

mooreca@roadrunner.com

(714) 529-9071

Microsoft Access

Science

306

12:00

Bob Dickson

robertbdickson@socal.rr.com

(714) 539-1304

PC Q&A

Irvine Hall

10:30/12:30

Jim Sanders

jsanders@ligasmicro.com

(714) 544-3589

Please report SIG changes to editor@noccc.org . Contact SIG leaders by e-mail, preferably, rather than by telephone.

Computer Talk
Word Tips

Updates from Ted Littman

Copyright © 2012 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word tips can be found
online at http://word.tips.net.

Selecting Lots of Graphics
If you have quite a few graphics on a page in Word, you may want to group them all together so they are treated as a
single unit. You can select each of the individual graphic items by holding down the Shift key and clicking on each
one, but there is a faster way.
If you are using Word 2007, display the Home tab of the ribbon. Click the Select tool at the right side of the ribbon,
in the Editing group. From the resulting choices, click Select Objects. The mouse pointer changes to an arrow and you
can then click your mouse and drag it to define a rectangle that encloses all the objects you want selected. Anything
within the rectangle is selected when you release the mouse button.
If you are using an older version of Word, simply click on the Select Objects tool on the Drawing toolbar. (The Select
Objects tool is the one that looks like an arrow.) You can then click your mouse and drag it to define a rectangle that
encloses all the objects you want selected.
To turn off object selection, just press the Esc key.

Editing a Hyperlink
Once a hyperlink is placed in your document, it is not unusual to periodically need to change the link
in some way. This is quite easy to do, using any of the following methods:

Position the insertion point within the hyperlink, and then click on the Insert Hyperlink tool on the toolbar.
Position the insertion point within the hyperlink, and then choose Insert Hyperlink from the Insert menu.
Right-click on the hyperlink, choose Hyperlink from the Context menu, and then choose Edit Hyperlink.
At the conclusion of any of these steps, the Edit Hyperlink
dialog box is visible. (See Figure 1.) The difference between
this instance and actually adding a hyperlink is that all the
information in the dialog box is already filled in. You can
make edits to your heart's content, and then click on OK to
save your changes.
Figure 1. The Edit Hyperlink dialog box.

Linking Text Boxes
Kylie wonders how, in Word 2010, she can link text boxes so that text flows from one text box to
another. She knows how to do it in Word 2007 (right-click on the text box and choose "create text
box link"), but it appears that option is not available in Word 2010.
Kylie is correct; it appears that the Context menu option she references is available in Word 2007 but
missing in Word 2010. You can still create a link between text boxes, however, by following these
steps:
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Create both of your text boxes.
Place your text (even if it is very long) in the first text box.
Make sure the second text box is empty—it should not contain any text.
Place the insertion point within the first text box.
Make sure the Format tab of the ribbon is visible. (This tab is only available if a text box is selected or if the insertion point
is within a text box.)
Click the Create Link tool, within the Text group. The mouse pointer changes to a cup containing a downward-pointing

arrow.
Click the mouse pointer within the second text box.
Taming Unruly Tables
When you first add a table to your document, Word determines column width by dividing the space
available between margins by the number of columns in the table. If you later add a column to the
table, the inserted column will push the right edge of the table past the right margin. This may make
it difficult to "grab" and resize the right-most column.
There are several ways to deal with this type of situation. For instance, you could change to
landscape orientation, adjust the column widths, and then switch back to portrait orientation. Another
thing to try is to switch to Normal (or Draft) view, as opposed to Page Layout (or Print Layout) view.
This allows you to see the columns that extend past the right margin and make any adjustments.
If you want to adjust all the columns so everything fits as well as possible, follow these steps if you
are using Word 2000 through Word 2007:
Right-click anywhere within the table. Word displays a Context menu .

Click on AutoFit. Word displays a submenu.
Within the submenu, choose AutoFit to Contents.
The result is that Word adjusts your table so as much of each column is as visible as possible, within
the limits of the page margins and according to how much information is in each column. This can
sound confusing, and the effects are best understood by trying out the feature with different types of
information in your table. If the table is empty, each column is made as narrow as possible, and you
end up with a "scrunched" table. If there is information in the table, then each column is made as
wide as possible to display all the information in that column. If the table is still too wide, Word
narrows the widest columns, thereby wrapping the contents of those columns, until it can fit
everything.
If you are using Word 97, a totally different method of fitting your columns has to be used. Follow
these steps, instead:

Select the entire table.
Choose Cell Height and Width from the Table menu. This displays the Cell Height and Width dialog box .
Make sure the Column tab is selected.
Click on AutoFit.
The effect on your table depends on whether your table contains information, or not. If the table is
empty, the columns are evenly resized so they fit within the page margins. If there is information in
any of the columns, the column width is set so that information fits on a line (if possible). Once your
column widths are set in this way, you can do any final column adjustment, as necessary.

Excel Tips

Copyright © 2012 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel tips can be found
online at http://excel.tips.net.

Printing Row Numbers
Maria wonders if it is possible to print out a worksheet and show the row numbers (1, 2, 3, etc.) on the printout. She
wants just the row numbers, not the column letters.
The short answer is no, it is not possible. Excel allows you to print both row numbers and column letters, but not row
numbers alone. You can, however, use a workaround to get row numbers. All you need to do is add a new column A
(insert a blank column to the left of the existing column A) and then use this formula in each cell of the column:

=ROW()
The formula returns the row number of the formula's row. You can then format the column to appear any way desired,
and then include the column in the printout. If you want to actually include a modified row number (perhaps you don't
want to show the row number of the first two rows, which contain column headings), you can either delete the
formulas in cells A1:A2 or you could adjust the row number starting in cell
A3: =ROW()-2 .

Setting Vertical Alignment
Excel provides several different ways you can align information from top to bottom (vertically) within
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a cell. You set the alignment by first selecting the cells you want to format and then displaying the
Alignment tab of the Format Cells dialog box. (See Figure 1.) (To display the dialog box, choose Cells
from the Format menu.)

Figure 1. The Alignment tab of the Format Cells dialog box.
On the Alignment tab, use the Vertical drop-down list to make your selection. There are four different
alignment options available in Excel 97 and Excel 2000, and five in later versions of Excel:

Top. The information in the cell is situated such that the top line of text appears at the top of the cell.
Center. Information is centered half-way between the top and bottom borders of the cell.
Bottom. This is the default vertical alignment. Information is aligned at the bottom of the cell.
Justify. Text is spread evenly throughout the cell. The information within the cell is wrapped within the column (if
necessary), and the row height is adjusted so that all lines fit within the cell and so all information reaches both the
top and bottom borders of the cell. Column width is not affected at all.
Distributed. This option is available in Excel 2002 or later versions. When selected, text is spread evenly between the top of
the cell and the bottom. Effectively, blank space is placed between each line so that the complete cell is filled.
Norton Tips

App Attack!: Four Things to Think About Before You Download
Are you prepared for an app attack? With the huge rise of mobile computing, the amount of malware, spyware, viruses
and things we haven’t even thought of yet is bound to grow:
http://response.nortonfromsymantec.com/servlet/cc6?
kPuHglLJQWTWTQSWVlLKtplxjhHKjmggLjQJhuVaVRVXLX
Scared Silly: Tips to Identify and Avoid
Scareware
It combines a classic scammer motivation – fear – with some pretty convincing technological fireworks. Scareware preys
upon our fears to make us take actions that ultimately end up compromising our own security:
http://response.nortonfromsymantec.com/servlet/cc6?
kPuHglLJQWTWTQSWVlLKtplxjhHKjmggLjQJhuVaVTSVXLX

The Graphics Side of Word, Part 1
By Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Inc., Florida; May 2011 issue, Sarasota PC Monitor; www.spcug.org ;
ndemarte (at) Verizon.net

It is natural to think that a word-processing program would deal only with words. Certainly, most commands in
Microsoft Word do relate to editing or formatting text. But each new version of Word has introduced more ways to
enhance text with graphical elements like clip art and photos. This article and the one next month will deal with the
graphics side of Word 2007 -- what the options are and how to use them within a Word document. Many of these
techniques apply to Word 2003 as well; all apply to Word 2007 and 2010.
This month the focus will be on the types of graphics that may be inserted within a Word document and how to insert
them successfully. To do this, we need to explore the Illustrations group within the Insert tab in Word 2007.
Inserting Pictures
Since a picture is worth a thousand words, often adding a photo to a document helps clarify its meaning. To do this,
open a Word document and place the cursor on the page where you want a photo to appear. Double-clicking in any
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blank space inside the margins will position the cursor at that spot. Click the Insert tab - Picture. Your Pictures folder
will open, allowing you to select a photo from your collection. Click the photo, and then click Insert to make the photo
appear in your document. Depending on its size, the photo may fill the screen, blocking out the text, or jump to the next
page. Instead of panicking, find one of the corners of the photo and drag it toward the center to reduce its size while
maintaining its proportions. When the photo reaches the desired size, right click it and select Text-wrapping - Tight or
Square from the menu. This will allow the photo to be moved around and positioned within the document with text
surrounding it. You can experiment with other text-wrapping choices if you want the photo positioned differently, such
as behind the text. Sometimes Text-wrapping is not visible in this menu. Choose Format Picture instead, then Layout, to
get the text-wrapping choices.
When you select the photo now, you will notice that a new tab called Format has appeared in the ribbon at the top of the
screen with the phrase Picture Tools above it. Click Picture Tools to reveal commands related to editing and formatting
the photo. These tools allow you brighten or crop the photo, add borders and effects, and change its position or size.
When you deselect the photo, notice that the Format tab and Picture Tools disappear.
Inserting Clip Art
Office 2007 has extended the definition of Clip Art to include not only the standard drawings and photos, but also
movies and sounds. There are thousands of these items which can be inserted into your documents. Open your document
and click the Insert tab - Clip Art. Fortunately, the Clip Art dialog box, which opens along the right side of the screen,
contains a powerful search feature. Begin by entering a search term, like "birthday cake." Then, using the drop down
menus, choose whether to search just on your computer, the Microsoft Office website, the whole web or all of these (best
choice). You can also choose which kind of media you want to search, such as clip art or sounds only. With a fast
Internet connection, it takes only a couple of seconds for the Clip Art search box to return items which meet your search
criteria after you start your search.
To add a clip art item to your document, merely drag it from the Clip Art box to your document. To add more than one
item at a time, hold down the Ctrl key while you select items, and then drag the whole group together. Once the clips are
in the document, follow the same general instructions for resizing, text wrapping, and moving as you did for photos. A
Help command at the bottom of the Clip Art box can help you solve any problems you encounter. You may close the
clip art dialog box when finished adding clips.
Inserting Shapes
Older versions of Word had a Drawing toolbar which gave access to a few shapes and tools for working with them.
Word 2007 has made a noticeable improvement in the number of available shapes and how shapes are organized. On the
Insert tab, click Shapes in the Illustrations group to open the expanded gallery. Click the shape you want, but don't
expect it to appear instantly in your document the way a photo does. Instead, you must click inside the document where
you want the shape to appear. Hold down the left mouse button and drag any direction to make the shape visible. Once
it's there, it can be resized by dragging one of the "handles" (small squares along the edge) and moved the same way as
clip art. Right-clicking the shape gives you a menu of options similar to those for a photo or clip art.
If you select the shape in your document, the Format tab appears again but with new commands. Click Drawing Tools to
see ways to enhance your object. For example, you can choose fill colors, effects, and arrangements of multiple objects.
If you are designing a complex arrangement of shapes, you may wish to use the Drawing Canvas tool which is found at
the bottom of the shapes gallery. This tool creates a large area in which to put multiple graphic elements to create a
complex drawing. The canvas keeps objects from moving around unexpectedly, but can be difficult to control.
A simpler way to work with multiple objects is to use the tools found in the Arrangements group in Drawing Tools. One
command lets you move an object to the front or back of the arrangement; another lets you rotate an object. An
especially useful command is Group, which is a simple way to put objects together. First arrange the objects in your
document. Then, while holding down the Ctrl key, select all the shapes you need. Click Drawing Tools - Group - Group
to merge them so they are treated like one object. If you want to split them apart, click Group - Ungroup.
These three types of graphic items -- pictures, clip art, and shapes -- were part of earlier versions of Word. They were
improved in Word 2007 by offering more choices and better organization of tools. Next month we will continue with a
look at a new graphic feature introduced in Word 2007 called Smart Art, plus the improved Charts element, and some
ways that text can become art as well.

Password Tracking –
Windows and Mobiles
By Merle Nicholson, Secretary, Tampa PC Users Group, FL
September 2011 issue, Bits of Blue; www.tpcug.org
merle (at) merlenicholson.com
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Tracking passwords has always been a problem for me. Years ago I started a password
Document to track everything, and, while it worked, it left a great deal to be desired. The problem was much larger than
just username and password. I needed to save the URL to log in to websites. I needed to track expiration dates for
subscriptions. I needed
key codes for software. I have ﬁve different logins with Microsoft. Yes, I could reuse some of those, using the same
login and password, but not always. For instance,
sometimes your login is the same as your email address, but most times not. Making it more complicated, different sites
have different login and password requirements.
And Verizon! I have SIX different logins with Verizon: Call Assistant, Verizon Central, Verizon FIOS, Verizon Mail
Account, Verizon Mail and Verizon Wireless.
So I developed some “password rules” for myself. I decided that if I could remember more than just a couple of
passwords, it was because 1) I had to reuse them (a bad thing) and 2) they were too simple. So something had to go. I
decided I need really good passwords and I couldn't handle it in my head.
One of my sons suggested the KeePassX database he'd been using for a while, and I started using it sparingly, slowly
embracing its features as I got used to it. The program is maintained professionally and is available free of charge. You
can look at the program at http://www.keepassx.org/ to see if this will suit your own needs. Of particular interest is the
variety of devices that it works on. You won't see any mobile versions
at the website, but each of the mobile devices has a version available from its own app store. I use the Android version
on my Motorola Droid X.
The program uses an encrypted database, and I guess ideally there should be a way to automatically update or
synchronize between devices. I own several computers and my Droid, and I need the database on all of them. I could use
Microsoft Live Mesh or Dropbox or something like that for synchronization, but I dislike the idea of my password
database being in the “cloud.” So for now I use a ﬂash drive to copy the database ﬁle
to my computers, and I connect my Droid to my base computer via USB and drag and drop the ﬁle.
I've found that, in practice, I don't have to refresh the ﬁles very often. None but the one on my main computer is up-todate at any one time, but it never seems to matter.
What is so useful about this program is that I can store any useful information along with the URL and the logon and the
password. For instance, my Amazon/Kindle account logon has the names and Kindle email addresses of two Kindles,
two Droids (smart phones) and two PCs. It's a logical place to keep all this stuff.
Right now I count 82 database entries, and I'm very careful to keep it trimmed of anything not useful. It has a
conﬁgurable password generator and the ability to look at the password when you want to instead of a line of *******.
I got an email to my Droid with a notiﬁcation of an event on the TPCUG forum before I would even think of ﬁring up
my main computer. I needed to log on using a regular account on the forum. The peculiarities of a smart phone with just
an on-screen keyboard that needed a complex login and password should have been just too daunting. But on the
Android version of KeePassX, when you select the group (TPCUG) and title (User Logon), the database puts two little
buttons in the notiﬁcation strip at the top of the screen. So when you open the browser to the site, you just poke the login
notiﬁer, then poke and hold on the login box and a paste menu appears that you poke and it's pasted in place. Then the
same for the password and I was in and out in seconds.
What a deal, and it's free. There are versions for Linux, Mac OSX, Windows, iPhone, PocketPC, Blackberry and
Android. And if you think you don't need one, your passwords are too simple and you're using the same one for
everything. Http://www.keepassx.org.

Bluetooth
Not a dental diagnosis or a rare tooth problem

By Phil Sorrentino, President, Sarasota PCUG, Florida
October 2011 issue, Sarasota PC Monitor; www.spcug.org
president (at) spcug.org
Bluetooth is the name given to a technology that uses short-range radio links, and is intended to replace the
cable(s) connecting portable and/or fixed electronic devices. The vision is that it will allow for the
replacement of the many propriety cables that connect one device to another with one universal radio link.
Its boasts such key features as robustness, low complexity, low power and low cost, and it was designed to
be operated in noisy frequency environments.
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Bluetooth is a communications standard for interconnecting electronic devices and is defined by the
Bluetooth specification. Bluetooth uses a form of data packet switching, a technology that is used to
transmit digital data via a wireless communications link. Bluetooth operates in the unlicensed ISM
(Industrial, Scientific and Medical) 2.4GHz frequency band, and avoids interference from other signals by
hopping to a new frequency after transmitting or receiving each packet.
Here is a little history, for you tech history buffs, to show how long Bluetooth has been around. Work on
Bluetooth was started in 1994 by two Ericsson Corporation engineers, and the Bluetooth 1.0 specification
was released May 1998. Version 1.0, with a data rate less than 1 Mb/s, had many problems, and
manufacturers had difficulty making their products interoperable. Bluetooth 2.0 was released November
2004 with a faster data transfer rate (approx. 2.1Mb/s). And finally, Bluetooth 3.0 was released April 2009
with a date rate of up to 24Mb/s with improvements and new features and is the current standard.
Bluetooth uses a radio technology called frequency-hopping spread spectrum which chops up the data being
sent and transmits chunks of it on up to 79 different frequencies. Bluetooth provides a way to connect and
exchange information between devices such as Smartphones, laptops, personal computers, printers, Global
Positioning System (GPS) receivers, digital cameras, video games, and others.
Bluetooth is an open, wireless protocol for exchanging data over short distances between devices, creating a
personal area network (PAN). It was originally conceived as a wireless alternative to the old serial RS-232
data cables. Bluetooth is a network and thus can connect many devices, unlike RS-232 which was strictly
serial point-to-point. Bluetooth is primarily designed for low power consumption, with a short range. Three
ranges are defined in the standard, 100 meters (Class 1), 10 meters (Class 2), and 1 meter (Class 3).
Because Bluetooth devices use radio (broadcast) communications, they do not have to be in line of sight of
each other. Bluetooth makes it possible for these devices to communicate with each other and transfer
information as long as they are in range.
Both Bluetooth and Wi-Fi are examples of wireless technology that use the unlicensed 2.4GHz frequency
spectrum. Both have many applications in today's offices and homes such as: setting up networks, printing,
connecting cooperating devices, and transferring data files among computers and smart devices. Wi-Fi is
intended as a replacement for cabling for general local area network access in work areas. Bluetooth is
intended as a replacement for cabling among equipment in close proximity. Wi-Fi is intended for use in
equipment as a wireless local area network (WLAN). Bluetooth is intended for use as a smaller, personal
area network (PAN).
A PC uses a Bluetooth adapter in order to communicate with other Bluetooth devices. While some desktop
computers and most recent laptops come with a built-in Bluetooth adapter, others require an external
adapter, usually in the form of a Bluetooth Dongle. Bluetooth allows multiple devices to communicate with a
computer over a single adapter. For Microsoft Windows platforms, Windows XP Service Pack 2, Vista, and
Windows 7, all have native support for Bluetooth. (Previous versions required users to install their Bluetooth
adapter's own drivers, which were not directly supported by Microsoft.)
Some of the more common applications of Bluetooth are:
§ Wireless control of and communications between a mobile phone and a hands-free headset. This was
one of the earliest applications.
§ Wireless communications with PC input and Output devices, the most common being the mouse,
keyboard and printer.
§ Replacement of traditional wired serial communications used in: test equipment, GPS receivers, Medical
equipment, bar code scanners, and traffic control devices.
§ Between game consoles such as Nintendo’s Wii, and Sony’s Playstation and their respective controllers.
§ Between video camera and remote monitor in Baby Monitor Systems.
§ Between Garage Door Opener Motor and Remote Garage Door Opener Controller.
As you can see from this list, there are many reasons for computer devices to communicate with each other.
Here is a quick computer communications concept tutorial. When any two devices need to communicate,
they have to agree on a number of things before the communication can begin. The first point of agreement is
physical: Will they talk over wires, or through some form of wireless signals? If they use wires, how many are
required; one, two, eight, 25? Once the physical attributes are decided, additional questions arise, such as
how much data will be sent at a time? For instance, serial ports send data 1 bit at a time, while parallel ports
send several bits at once.   And, how will they speak to each other? All of the devices in an electronic
network need to know what the bits mean and whether the message they receive is the same message that
was sent (i.e. checksums at the end of a message).
This means developing a set of commands and responses commonly known as a Protocol . Bluetooth is
essentially a networking standard that defines these two levels, physical and protocol. Bluetooth protocols
simplify the discovery and setup of services between devices. Before any communications can take place
between two Bluetooth devices, they have to be paired. In order to pair two Bluetooth wireless devices, a
password (or PassKey) has to be exchanged between the two devices. A Passkey is a code shared by both
Bluetooth devices, which proves that both users have agreed to pair with each other.
A very brief description of Bluetooth pairing is as follows: Bluetooth Device A looks for other Bluetooth devices

in the area. Bluetooth Device A finds Bluetooth Device B. Bluetooth Device A prompts you, the user, to enter a
password (or PassKey). Bluetooth Device A sends the Passkey to Bluetooth Device B. Bluetooth Device B sends
the Passkey back to Bluetooth Device A. At this point, Bluetooth Devices A and B are paired and able to exchange
data. Data between the devices will be accomplished wirelessly, over-the-air, a great boon to those who dislike the
“rats nest” of wires typically found behind electronic devices.
So, although dentists probably cringe when they hear the term, with all the computer devices you may have or are thinking of getting,
there’s probably a Bluetooth in your future.

Create a Building Block in Word 2007 or 2010
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By Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Inc., FL October 2011 issue, Sarasota PC Monitor

www.spcug.org ; ndemarte (at) Verizon.net
If you create many documents in Word, you may find that you often include portions of text with similar content or format. For
example, when preparing to submit SPCUG classes each month to the Monitor, I always include a list of the details: dates, day,
time, location, instructor, and instructor’s email address. As I learned more about Word 2007, I realized I could set up a skeleton
format for these class postings and save it as a “building block” (aka Quick Part) in Word. When I needed to prepare a new class
posting, all I had to do was insert this building block into a document after the class description and enter the specific details,
saving me the hassle of recreating the format.
New in Word 2007, building blocks are related to templates except they are bits of text, rather than a whole document. For user
convenience, a complete set of pre-formatted building blocks is listed on the Insert tab in the Text group under “Quick Parts.”
Click the Building Block organizer to find pre-formatted text boxes, headers and footers, cover pages, page numbers, and more.
Many of these building block galleries are also available under their own icons throughout Word. The Building Block organizer,
however, includes all the categories in one place. You can insert any one of these blocks into a document or template by opening
the document, placing the cursor where the block belongs, clicking the Insert tab, then Quick Parts, Building Block organizer, and
the building block you want. If that sequence seems too cumbersome, you can add the Building block organizer to the Quick
Access menu. Right click the organizer title and select “Add to Quick Access toolbar.”
Creating your own building blocks is easy and can save you lots of repetitive typing. The first step is to create a piece of
formatted content. Let’s use the example of a logo which could be used in a letterhead, business card, and other documents. Since
building blocks may contain many types of content, such as lines, images, drawings, and tables, as well as text, I created one using
a table with text and a piece of clip art from the Word program. Here’s how it looks:
OTS
Oakes Tree Service
Richard Oakes
Phone: 941-921-8006
Email: otrees@verizon.net
My next step was saving the building block. I selected the logo, clicked the Insert tab, then Quick Parts, and chose “Save
selection to Quick Parts gallery.” This action opened the “Create New Building Block” dialog box, where I gave my block a
Name, OTS logo. In the Gallery area, I left it labeled ‘Quick Parts’ because it didn’t fit into any of the existing galleries. Under
Category, I created a new one called Nancy, which let me group all my custom building blocks together for easier access. I
skipped Description, although if I had I added one, it would have become the Screen Tip for the block. I left the Save In and
Options boxes as they were and clicked OK to save my changes.
Now it was time to try adding my new building block to a document. I opened a blank document and double-clicked about half
way down the page to position the cursor there. Then I clicked the Quick Parts icon on the Insert tab, which showed previews of
my last three custom building blocks. I clicked OTS logo and it appeared in the document where my cursor had been. Had the
block not been visible as a preview, I would have clicked Building Block organizer and scrolled to Quick Parts under the Gallery
column to locate it.
Next I decided to change the font in the logo heading. I knew that any building block can be modified in a document without
changing the version stored in the Building Block organizer. I changed the font of OTs from Goudy Stout to Bodoni MT black.
As an experiment, I saved the modified version to the Quick Parts gallery with the same name and properties as the first version to
see if it would overwrite the original. I was surprised to find that it did not. I ended up with two different versions with the same
name. I decided it is necessary either to delete a first version before saving a second or give the second version a different name.
Finally, since the logo block was only for illustration purposes, I decided to delete it. I simply opened the Building Block
organizer, scrolled to and selected OTS logo, and clicked Delete.
My own collection of custom building blocks includes a footer which includes my name, page number and current date; a
copyright sign with my name; the SPCUG class detail list; and a personal logo I use as a letterhead. I do, however, often select
from the galleries of pre-formatted building blocks located on almost every tab of Word 2007; for example, watermarks on the
Page Layout tab, cover pages and text boxes on the Insert tab, or Table of Contents and Bibliographies on the References tab.
More building blocks are available at www.office.microsoft.com.
The more I customize my Word 2007 program, the easier tasks become. Creating custom Building Blocks is one more way to
make Word 2007/10 my own.

Product & Book Reviews
Products Available for Review
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The NOCCC regularly receives copies of books and sometimes software from vendors for our review. We can also request
specific products for you to review. These reviews are published in this newsletter, the Orange Bytes. Then, you get to keep the
book or software. If you are interested in doing a review, please send an e-mail to reviews@noccc.org and provide your
membership number, phone number, and e-mail address. You can pick up the product in the lobby of Irvine Hall between 9
A.M. and Noon at the regular monthly NOCCC meeting
Note to Reviewers
• You have 2 months to submit a review. Due-cause time extensions must be requested from the Reviews Editor.
• You must leave a security deposit (check, credit card number, or cash equal to the product’s list value.), returnable upon our
receiving an acceptable review.
• If you decide to return the product without reviewing, there is a $2 penalty after the first month and a $5 penalty after the
second month.
• Guidelines for preparing your review are addressed on the next page.
Books
Social Networking & Internet
New: On Top of the Cloud: How CEO’s Leverage New Technologies to Drive Change & Build Value Across the Enterprise –
Authored by Hunter Muller from John Wiley & Sons. MSRP=$65.
New: The Internet for Dummies – Authored by Levine & Young from Wiley. MSRP=$25.
Twitter for Dummies – How to connect with others in 140 characters. Book by Fitton, Gruen, & Poston from Wiley.
MSRP=$22.
New: Twitter Marketing for Dummies – Use Twitter to build your network, spread your message, & communicate with your
customers. By Kyle Lacy from Wiley. MSRP=$25.
New: LinkedIn for Dummies – How to join & use the largest online network for professionals. By Joel Elad from Wiley.
MSRP=$25.
New: Mom Blogging for Dummies – Learn how to set up your blog and use it to sell your products & services. From Wendy
Piersall from Wiley. MSRP=$25.
New: The Back Channel – How audiences are using social media & changing presentations forever authored by Cliff Atkins.
From New Riders. MSRP=$35.
The Digital Afterlife – How to secure your digital assets for your heirs. By Evan Carroll & John Romano from New Riders.
MSRP=$25.
Mining the Social Web – Analyzing data from social media sites by Matthew Russell. From O’Reilly. MSRP=$40.
Digital Photography & Design
New: The Photoshop Elements 10 Book for Digital Photographers – Authored by Scott Kelby & Matt Kloskowiski from New
Riders. MSRP=$50.
New: Adobe Photoshop Elements 10 Classroom in a Book – The official training workbook from Adobe Systems. From Adobe
Press/Peachpit Press. MSRP=$45.
New: The Portrait Photography Course – Principles, practices, & techniques. By Mark Jenkison, from Peachpit Press.
MSRP=$40.
New: Professional Portrait Retouching Techniques for Photographers using Photoshop – Learn how the pros do it. By Scott
Kelby, from New Riders. MSRP=$50.
Canon PowerShot G12 – From snapshots to great shots by Jeff Carlson from Peachpit Press. MSRP=$25.
The Photoshop Elements 9 Book for Digital Photographers – New Riders book by Scott Kelby & Matt Kloskowski.MSRP=$50.
New: Adobe InDesign CS5 Classroon in a Book – The official training workbook from Adobe Systems. Includes a CD. From
AdobePress. MSRP=$55.
Real World InDesign CS4 – This book covers the waterfront on Adobe’s new design suite. Authored by Olav Kvorn & David
Blatner, it is published by Peachpit Press. MSRP=$55.
Your book reports will be published here.
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SIG Meeting Reports

Visual Basic for Applications
(Access/Excel VBA)
By Bob Dickson, SIG Leader

Preview of the June Meeting:
These two data management tools, Access and Excel, are widely used. Microsoft has ‘packaged’ them so that using them ‘as
installed’ will produce useful results. But if one wants to ‘get under the hood’ and produce customized and unique results, one has
to become familiar with VBA (Visual Basic for Applications), the programming language used to create results that are not
available using just the vanilla version of the app. VBA is based on Visual Basic, a major programming language used by
professional programmers to create programs to run General Motors, the US Government, Banks, and many other giant
organizations. We don’t study VB itself as that is beyond the scope of this
SIG. Microsoft has included VBA in all of the MS Office apps. Knowledge of VB makes learning VBA
easier but it’s not required to know VB to learn VBA itself. In this SIG we’ll explore using VBA
programming to achieve results not possible with the standard app.
While the ‘standard’ VBA features are common, each app requires some work to be comfortable coding
in that app, particularly in accessing the various objects in the app. Some members have shown results
that are truly professional quality yet the person is self-taught. It can be done! But it takes some effort and
determination. In this SIG we’ll work on demonstrating VBA coding to achieve unique and useful results.
The object is to lay the foundation that one can build on for more useful end results as one’s confidence
and knowledge grows. Join us in Science 306 at 10:30 am to noon. If you have some experience with VBA, share it. If you’re
interested in learning to use VBA, come up and tell us what you would like to see a solution to.
Report on the June Meeting:
The June session was mostly devoted to creating Menu Items. This was a new area for me. Our mentor, Richard, introduced us to
them a couple of months ago. Menu Items are places in the standard menu line at the top of the screen. In the standard package,
one can customize the menu line using a large list of items that are prepackaged. That’s great and very handy for almost all needs.
However, there is a programming method in VBA enabling the developer to create unique menu items that are made available only
under program control. Where this capability came in really handy for me was to permit me to eliminate a
large number of command buttons from a user form. I’ve used command buttons < on user forms in Access for many years. No
problem. However, with a user form in Excel, having lots of command buttons on the form ‘fills it up’ and detracts from the main
function for which the user form was created. By creating menu items, I was able to move the functions of the command buttons
up to the menu line, reduce the size of the user form, and eliminate some distractions from the operator. In Excel (although, I
think, not in Access) having the command functions in drop down lists from the menu line just seems more natural. If you are not
familiar with creating menu items, join us in Sci 306 from 10:30 am to noon, and we’ll be happy to share our experience using this
neat feature. By the way, don’t try to find out about programming your own menu items by clicking on the Excel HELP button:
you’ll only see lots of verbiage about the standard list of items to customize the standard menu line.
We also had some good discussion about using Macros vs. subroutines. Richard prefers not to use macros. He codes all of his
routines directly into subroutines. I have to admit I’m still gaining knowledge in this area. Whenever I created a new menu item,
the compiler always created it in a macro. Hey, it worked just fine. I had originally coded all of the functions of the command
buttons in the main program. When I started creating the menu items, I had to move the code to the macro created by the compiler.
That was a bit of a learning curve but, hey, that’s what we do in these SIG sessions: learn new things. Friends helping friends: I
love these SIG sessions. Buy a donut, fill your coffee cup and come on up. Do you have some neat tricks you use? How about
sharing them with us? Got some questions? Ask us. Helping you find an answer extends our knowledge, too.
This SIG meets in Science 306 at 10:30

MS Access
By Bob Dickson, SIG Leader

Preview of the June Meeting:
Swamped with a mountain of files? Can’t find ‘that’ important piece of data? Endless scrolling through
rows and columns of data to find the ‘right place’ to make that update? Well, don’t despair. There is
software that can help you get over the hump and get control of your data mountain. Spreadsheets are
good and very useful but have you considered moving your records to a DATABASE? In Excel, data is
stored in rows and columns and accessed by cells. I love Excel spreadsheets and have used them for years
for routine business functions. I can’t imagine trying to run a business without using Excel (or other
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spreadsheet) program. I’ve always considered Excel to be the Swiss Army Knife of business software.
But you can’t use a knife in every situation. When it comes to managing files of data, the answer is a ....
DATABASE. Forget those rows and columns. Store, and manage, your data in RECORDS and TABLES! There are many
database products out there but in this SIG we only discuss Microsoft ACCESS.
While not included in the standard MS Office package, ACCESS can be purchased separately or be included in the MS Office
PRO package. In either case, ACCESS is fully integrated into the MS Office software and communicates seamlessly with all other
packages in the MS Office Suite. And there’s only one ACCESS. That is, one doesn’t have to acquire a more powerful version
just to be able to perform certain business functions. When you have ACCESS, you have it all. The version I have installed on my
laptop is the same version one would use to process the files for a large business or the files of a single person.
Well, you’re interested in this ‘database thingy’ but it sounds too complicated. NO, no, no. Microsoft has packaged this product
such that, right out of the box (or just after the download), one can do some neat little things without having to spend days and
weeks digging into details. OK, yes, one must be willing to do a little studying and experimenting but MS has provided lots of
templates for all kinds of applications. One can easily spend hours just playing with all of the templates and samples that
confidence builds quickly in wanting to ‘get on with it’ and build your own first database. That’s what Helen’s been doing, with
my assistance, over the past year. She’s built two databases: one of her quilts collection and one of her dolls collection. The data
about those quilts and dolls was jammed into 3-ring binders with notes in the margins and handwriting on separate pages.
Together, we organized all the data into one database of her quilts (she has been making them for decades) and another one for her
wonderful collection of dolls. She now has all that data, and pictures (!), in databases on her laptop where she can proudly display
them to visitors and friends. She also printed hard copies and has wonderful 3-ring binders of computer-generated pages.
The SIG sessions will cover the fundamentals of ACCESS and explore working with the application ‘right out of the box’. If you
have an interest in databases and how you might use this wonderful data management tool, or if you have experience using
ACCESS, come up to Science 306 at Noon (till 1:30 pm) and either, see how this tool might be useful for you, or share with us
your experience using it. We’ll get out in time to get to the general meeting.
Report on the June Meeting:
The June session was a standard routine of going through some of the standard features in Access. Our Dolls Collection gal,
Helen, was travelling out of town and besides, that project has been pretty much ‘put to bed’. So it was back to digging into the
standard features of Access ‘out of the box’. There’s so much provided in this app that one can spend boo-coo bunches of time
getting familiar with even just a few of them. Access is not included in the standard MS Office package. It has to be purchased
separately or purchase the MS Office PRO package, which includes Access. In the absence of a major project, we’ll be starting to
review in more detail the features of this wonderful app so that the person, new to using it, can see what’s available without having
any programming experience (for projects that require some programming knowledge, see the SIG session on Access VBA). A
very useful item to understand is the ease with which Access and Excel can exchange data. The datasheet view of an Access file
looks just like the Excel spreadsheet so one can import and export files between the two apps very easily. Join us in Sci 306 from
noon to 1:30 pm. We’ll get you out in time to attend the main meeting at 2 pm.
This SIG meets in Science 306 at Noon

Mobile Computing
By Ben Lochtenbergh, SIG Leader

June Meeting.
Tom Feeley downloaded the Microsoft PowerPoint viewer on two of his PCs and
was viewing this month’s presentation on his laptop even before I could set up my
laptop PC in the classroom. I included the download information and link in the
monthly email to the 23 on the list. My wife could view it on her Blackberry. Her
download took 10 minutes instead of 20 minutes because there was only one
attachment this time.
Two people, Muriel Fitzsimmons and Bill Thomas, brought in their newly bought devices and the data about them was shared and
entered into the SIGs database. We now have 31 devices in that Access database but only 17 are actively brought to SIG meetings.
I will have to do some Access programming to filter out the none-active devices and then email the active device owners the data
we currently have. The idea is to share and better understand the information we have collectively.
Perhaps funny, I learned a new lesson: I’d bought a set of dry erase markers to write on the whiteboard in front of the classroom.
Since it came in 12 colors I picked the color Orange. Well, I learned the writing was not readable beyond the first row. I hereby
apologize for that and promise to use a black marker next time.
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In the early part of the meeting we went into some of the basics like viewing what Android version the new Bionic 4G device has
and look for system update availability. Also, we touched on how to search for and download an app.
Richard Miller asked a pertinent question about how to view the SIG presentation on a DROID smartphone. I deferred the
question because we are still struggling with every one viewing the SIG presentations on their PC. I had not done that viewing for
about a year, we only have 90 minutes, and I wasn’t certain of the outcome. A few days later I emailed him my answer, not at
least because he also initiated the question via email.
I again showed DROID 2 running the free Microsoft Windows 7 Phone app for Android named Launcher7. Bill Thomas
commented there is also an app named Laucher7-Pro which costs money. I’m considering buying it because I like the tile
interface. If I were to put in words why: “I like it’s the simplicity”. The screen shows only 8 tiles at a time. My most favorite ones
are therefore close to the top, scrolling down is an option to see more tiles. One can easily rearrange his tiles. I have 11 favorite
titles which surely will increase. When I need to see all my apps I slide the screen to the left (they appear from on right). An
alphabetic list appears and sliding the screen up (they appear from the bottom) will eventually show them all. It has a search that
accepts typed text and partial words, but not voice. Then if one sees the one he wants, just touch the line and the app starts as
usual. That is as if you don’t have Launcher7. At the bottom there is a line with an ad which doesn’t slide away but is present all
the time. It is smaller in height then the 9 tiles you see at a time, thus not too intrusive. But for a few bucks you can eliminate that,
I assume. You can change the color of all tiles at once when going into Launcher7 settings. I counted 14 settings.
If this is a fair representation of the Microsoft smartphone operating system user interface then the rest may be good too. It may
make it big in the market place eventually. I see some glimpses of genius behind the design like what I saw when I first Windows,
Excel, and Internet Explorer came out. Don’t count Microsoft out.
This SIG meets in Science 109 at 10:30 a.m.

Linux Desktop & Administrator
By Bob Ray, SIG Leader

Linux combined SIG report of June 3, 2012.
We did a brief review of the Python API. We then had a short discussion reqarding all
of the hype surrounding Cloud Computing. We spent some time examing the use of
Cookies in the Internet Browsers... How they are used and how they both effect and
affect your privacy.
We created a menu driven BASH Shell script using some command line functions to
display and list some Linux Administrative features.
We installed the OpenCobol 1.1 version from source code and then proceded to compile some test programs.
These SIGs meet in Science 131 at 9:00 a.m .and 10:30 a.m.

Beginner’s Digital Photography
By John Krill, SIG Leader

This SIG meets in Science 131A at 9:00 a.m.

Advanced Digital Photography
By Larry Klees, SIG Leader
This SIG meets in Science 131A at 10:30 a.m.
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PC Q&A
By Jim Sanders, SIG Leader
Jim’s two SIGs meet in the Irvine Hall at 10:30 a.m. and 12:30 p.m., respectively. The first is the
Beginner’s PC Q & A and the second is for everything and everyone else.

Understanding Operating Systems
Charlie Moore, SIG Leader
A continuing discussion group about Operating Systems for computers.
This SIG meets in Science 111 at 10:30 a.m.

Visual Programming
Anson Chapman, SIG Leader
A continuing discussion group about computer programming using Visual Basic, Visual Basic Script, Visual C, Visual
C++ and Visual J++ for Beginners.
This SIG meets in Science 111 at 9:00 a.m.

Laptops, Smartphones, and Social Media
By Dr. Pat Adelekan, SIG Leader
This SIG meets in Science 109 at 9:00 a.m.

Microsoft Office
Tia Christian, SIG Leader
Open forums for problems incurred using Microsoft Word, Excel, Outlook versions 2003 to 2007, and Open Office and their
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resolutions.
This SIG meets in Science 306 at 9:00 a.m.

From the Desk of the Membership Chairman
By Ben Lochtenbergh, bal@msn.com

Our club membership, reported by our treasurer John Heenan, is again 172. For December, January, February, and March we have
no decline in membership! The underground parking had a gain of 10%. John reported 11 tickets were turned in at the raffle,
compared to 10 tickets in March. I know, this is a little farfetched, but I nevertheless enjoy reporting favorable statistics. The
merging effort with another computer club is effectively dead. They considered merging with us but concluded that it doesn’t serve
their purpose. Our chance to get a president, web manager, and a few new members from that club hereby evaporated.
But, there is good news. Very good news indeed. Rudy Lauterbach stepped up to become our webmaster
and newsletter editor/distributor. That means even though we won’t receive the paper Orange Bytes
this month, we’ll still have crucial communications with the majority of our members! Members that
have not given their e-mail address to John Heenan to enter in our membership database won’t receive a
newsletter during the period we have no paper Orange Bytes. I see no way to get this information to
them without them having and sharing their email address. They won’t even get this writing unless they
have the initiative to browse www.noccc.org and click Orange Bytes. If any member talks with such
member about this, please tell them. I have no better ideas. I just browsed our new newsletter, saw what
Rudy has done so far, and found it looking good already!

FREE AD SPACE
If you are an NOCCC member, and have a computer-related, non-commercial or “Talent Available” ad that you would like to
have placed in this newsletter or on the NOCCC web site, send an e-mail with a copy of your business card or ad to the
NOCCC Editor at editor@noccc.org .
Your business card would look good here!!!
For information about advertising in the Orange Bytes, contact editor@noccc.org.
NOCCC members Classified ads cost $5 for 1-25 words and $10 for 26-50 words.
Commercial display advertisements are welcome: contact editor@noccc.org.
RATES
One Page Vertical
Half-page Horizontal
Half-page Vertical
Quarter-page
Business Card
Center Spread

7.0” x 9.5”
7.0” x 5.0”
3.5” x 9.5”
3.5” x 5.0”
3.5” x 2.0”
14.0” x 9.5”

$ 150
$ 80
$ 80
$ 45
$ 15 >
$ 300

Deadline: Tenth of the month. Discounts: 3 months=10%, 6=15%, 12=20%. If you are interested in advertising in the publications
of multiple User Groups throughout the region or nationally, you can learn more by contacting http://www.apcug.org. Readers,
please tell our advertisers that you saw their ad in the Orange Bytes.

Transportation Information
Meeting Information
The NOCCC meetings are held at Chapman University, in the Hashinger Science Center and Irvine Hall, near the corner of
Center Street and Palm Avenue.
Parking Information:
Most of this information is on the back cover. For more information, see www.chapman.edu/map/parking.asp. A map of the
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Chapman University campus is also available at www.chapman.edu/map/map.pdf .
Bus:
Several Orange County Transportation Authority (OCTA) buses service Chapman University. Route 54 runs East and West on
Chapman Ave. The 59 runs North and South on Glassell Avenue, but doesn’t start early enough for the 9:00 a.m. SIGs. Get the
most current information or use a trip planner at www.octa.net . OCTA also has a Consumer Information Center at (714) 6367433 (RIDE).
Railroad: Metrolink trains can get you to the NOCCC meeting from the Inland Empire. There are stops in the cities of
Riverside, Corona, and Anaheim Hills. Parking your vehicle is free at the train station. See M on map below On Sundays,
Inland Empire-Orange County Line train 859 leaves San Bernardino destined for Orange County at 8:55 am. For the return trip,
train 663 leaves nearby Orange Metrolink at 3:11 pm and train 860 leaves at 5:37 pm. The Metrolink station is four-and-a-half
blocks from Chapman University. For specifics regarding your trip, check the web site: http://www.metrolinktrains.com or call
1-800-371-5465.

Board Meeting Minutes
Monday, June 4, 2012
This meeting was recorded and sent to Steven Breitbart who wrote up the minutes. It was not always clear what was being said
or by whom.
The NOCCC Board held its regular monthly meeting at President Jim Sanders’ residence on Monday, Jun 4, 2012, at about
7:30 p.m. All Board members were present except for Steven Breitbart and Gerry Resch. Jim will record the meeting for Steven
to transcribe it later.
Secretary’s Report: Pat stated that Steven didn’t put in all the information about the discussions of elections. Jim read the
minutes out loud; he was OK with them, and later Pat was also. A motion was made to accept the minutes. It was seconded and
passed unanimously.
It was explained that Jim, as Ex-President is an Ex-oficio member of the Board and is a non-voting position. Also he can’t be a
Director at the same time. Pat wanted a hard copy of the current bylaws. Jim said the entire bylaws are on the web site. Tia
wanted to know if they are the original copy. Jim explained that the original has been modified several times and only the latest
and current is on the web site. Gordon asked if an archival web site exists. Jim said there might be one, but didn’t know if it
had old versions of the bylaws. Tia also wanted to know if there are records of ratifications for the bylaws. Jim said that unless
individuals have old copies of the bylaws, the older versions aren’t available. However, Jim and Larry said that few and minor
changes have been made to the bylaws over the years. Gordon asked if Gerry had been ever Pres. and to ask him about older
versions of the bylaws. Larry said to ask Tracy Lenocker, one of the founding members. Gordon then said he did not know if
reconstructing the original bylaws would by useful. Pat said we need to know our history, and will take on the chore of
investigating the original bylaws herself .
Treasurer’s report: Members: family 3, newsletter 12, regular 139, three-year regular 7, for a total membership 161 people,
down from 172 last month. The raffle netted $67. 6 parking tickets were redeemed, down from an average of 9.8/meeting.
The net for the coffee table was a loss of $2.23, including the purchase of coffee, cookies and donuts. Net income for the day
was $64.77.
Parking issues were brought up: The university spent the money for the underground garage, and they changed the rules for
where you need a University needed in the area of private houses several blocks around the University. This includes
handicapped people. It was moved to pass the Treasurer’s report as delivered. It was seconded and passed unanimously.
The next regular meeting will be on July 15, which is the third Sunday of the month. The next board meeting will be July 16,
2012. Jim wants to send out at least two reminders. He forgot to mention this unusual date at the meeting.
Opening and Closing: There was a bit of excitement for the main meeting due to the theft of several artifacts in some of the
showcases in Irvine Hall. The consignment table and book review tables couldn’t be set up; we couldn’t get access in time to
set up in 131 or 131a. Our cabinets were locked when Richard finally opened the closet. None of our inventory appeared to be
missing. Speakers and obsolete books in the cabinet may be moved or recycled and that space could be used for some of the
equipment Jim regularly brings to the meeting. Jim mentioned that some of our property was left on the open shelves for year.
Security did not lock the store room until Jim called them.
Tia raised the issue of safety of the members. Richard suggested programming the campus security phone number into your
mobile phone. The security phone number is (714) 997-6763, is in the Orange Bytes (just before the Help Line Volunteers) and
on the back of the Board meeting agenda. Larry suggested that theft of artifacts is not indicative that members are in danger.
John noted the schedule of SIGs was not posted. Ted used to post copies of Page 1 of the Orange Bytes. Since the Bytes was
not printed, the schedule was not posted.
General meeting – Elections – Larry Klees volunteered to be on the Board, so we had all Director slots accounted for. No
competition was needed – everyone won by default.
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Bob did a very good job talking about Access. About 30 people were in attendance.
Programs: We still need another person to be a speaker for July. Ben said he could do something about it(inaudible). Larry is
seeking information on a current program that synchronizes two folders. Jim suggested a talk on Mosaic. Gordon wanted to
learn more about XP mode in Windows 7.
Public Relations: Jim had no input. Richard wants to advertise on the University website calendar. A guard told him we should
be on it for security purposes. He also contacted the University newspaper about an article about the club. Ben wants to mention
that our President and Vice President are both Drs. Pat asked if there had been another woman as President. Jim told her about
Elise Edgell and Cathy Margolin and to look at the archived Orange Bytes for more information.
Publications and Reviews: No reviews table was set up. Richard didn’t send Gerry information about the reviews table. He is
also planning to give Gerry several books for next months raffle. He will try to run the Reviews table from around 11:00 a.m.
to 1:00 p.m. on even months.
Rudy talked about the Web site, which is one long web page because it is easy to print out an issue, which is 25 pages long.
Links are present to archived Orange Bytes. Larry talked about one member who complained he couldn’t print a copy. Gordon
suggested that Rudy do a presentation at the next meeting on the new web site. John also would like a hard copy and suggested
reducing the cost of membership if we don’t produce a hard copy. He also suggested two classes of membership, one with and
one without getting a hard copy. But other costs would change if we fell below our typical print order of 200 issues. Printing,
postage, shipping, etc. would all change, and it may cost us more to send fewer issues. Jim suggested tabling the issue.
Someone said the Orange Bytes was created in Word, then converted to PDF format. Rudy is working on modernizing the
coding of the web site. He also suggested a link to games would attract new members and a feedback page for members to send
anonymous comments to the directors. We might have to have it set up where each member chooses a member user name and
password.
Pat made a motion to keep the bulk mailing permit, suggesting it could be used for other things besides the Orange Bytes.
Seconded and passed unanimously. John will renew the permit. Rudy said we could email the PDF to each member and they
could print it out. This would save the club the printing and postage costs.
Membership: Rudy will change to the July issue on July 5th. Ted said we should have a firm schedule for the changeover,
unrelated to the date of the next meeting, otherwise people will be late at submitting input. Jim said its OK to extend the
deadline in this case; for example 10 days after the Board Meeting.
Raffle: Nothing purchased yet.
SIGs: Beginner PC Q&A was cancelled due to the crime scene. Dallas walked around several times and took attendance of the
SIGs. Linux 5, Visual Programming 0, Laptops Smart phones, & Social Media 3, Beginning Digital Photography 7, Word,
Excel and Outlook 2, Linux 7, Access/Excel VBA 3, Advanced Digital Photography 5, Understanding OS 4 (changed to room
127), Mobile computing 11, Access 2, Advanced PC Q&A 19 and the Main Meeting 30.
Old Business: Larry found box for a projector and put it in the storeroom. Gordon also brought up the subject of projectors; Jim
bought a new one to replace the projector that stopped working.
There is no official policy that we can use University projectors. Larry says one projector shuts off automatically as if on a
timer, another needed a filter cleaning.
New business: Changing of Officers; Ted recommended that Jim introduce Pat to Judy Harker and other employees of
Chapman University. One person (name inaudible) is taking over the scheduling of the rooms we use.
As new President, Pat addressed the Board: Her message was “Go in with an open mind, learn the issues. It will take time.” She
gave out 2 sheets to each Board Member. She wants to have Board meetings at a conference room where she lives, leaving
meeting time at 7:30 p.m. Her vision is about 100 people in attendance for the Main Meeting and 20 people in each SIG. She
wants to increase membership by 30 people by December, 2012. A Community Service Dept exists where students can help us
recruit. She also wants a syllabus and timeline for each SIGs. The goal is to have multi age, tech savvy NOCCC teams.
Pat also handed out a sheet to each Board Member to be filled out and returned to Pat. She wants information on the position
you are holding, your goals, the requirements of you position, your career, hobbies, etc. She wants to create a small booklet
with a one page description of each Board Member to show prospective members.
Pat mentioned an acronym that we might use: “SAY YES” meaning - Seniors Affirming Youth and Youth Endorsing Seniors.
At this time, too many people were talking at once. Some items may have been inadvertently omitted.
Richard said there haven’t been this many changes in many years. Larry said that he is surprised the club is still in existence,
since many answers are easily available, but the industry is too large for one person to know it all. “There's no more gurus in
computers any more”. Someone suggested a SIG on Robotics. Richard wants to allow students from several colleges to present
to our SIGs or the Main Meeting. An idea for a lecture topic was Google Plus.
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Gordon made a motion to adjourn, which was seconded by Richard. The motion passed unanimously at 9:57 p.m.
Steven M. Breitbart, P.E.
h) (714) 486-3070
c) (714) 421-1118

NOCCC Bylaws

The club’s Bylaws are available here: Noccc9-97BylawsAsAmended-1-4-09.pdf

Renewed Members in May 2012 . . .
NOCCC Fee Schedule

The fee schedule has been set up to increase club membership, attract people with an interest in computing, and attract local computer-related businesses to
place ads in the Orange Bytes with or without becoming NOCCC members. We are also offering members the opportunity to help our club financially
by making donations that should be income-tax deductible since we are chartered as a non-profit 501(c)(3) organization. Donors will be
acknowledged in the Orange Bytes and the Membership level will be shown on the Member’s Badge. Your regular dues is tax deductible!
Membership Level ($) 1 Year 3 Years
Individual Member....................................................35.........90
Each Additional Family Member..............................15..........40
Full-Time* Enrolled College Student.....................20
Enrolled High School Student...................................15
*Minimum 12 Semester Hours
Business Member + Ad (Business Card)................180
Business Member + Ad (¼ Page, ½ Page)...............465 , 800
Business Member + Ad (Full Page).........................1,475
Membership Donations ($)
Contributing Member................................................75
Supporting Member...................................................100
Advocate Member.......................................................250
Patron Member...........................................................500

Links to other Computer Clubs
To provide additional information to our members, we are now listing the web addresses of other computer clubs.
Updates from Ted Littman.
Region 10 of APCUG (Association of Personal Computer User Groups)
www.noccc.org
North Orange County Computer Group
www.orcopug.org
Orange County PC Users Group
cugr.apcug.org/
Computer Users Group of Redding
www.thepcclub.org/
Laguna Woods Village PC Club
SCPD-ComputerClub.org
Sun City Palm Desert Computer Club
www.lacspc.org
Los Angeles Computer Society
www.mbug.org
Monterey Bay Computer User Group - PC
www.oakmontpc.com
Oakmont PC Users Group
www.pcc.org
PC Community (Hayward, CA)
pmlcug.org/
Pine Mountain Lake Computer Users Group
www.scvpcg.org
SCV Computer Club (Newhall, CA)
www.topcc.org
Thousand Oaks Personal Computer Club
For all regions, see: www.apcug.net/members/newsletters_index_page.htm

Pig SIG Open to All
Meet us outside Irvine Hall from about noon to 12:30 p.m. There are several benches where NOCCC people gather, eat and chat. Just look for the member
badges, grab a chair and join in! This is an informal group; so many different subjects are discussed. It’s a great opportunity to mix, mingle, and network!

Free coffee & tea at the April meeting!
Donuts $1/Each & Cookies $.50/Each

No Freebies!
Put your dollars & quarters in the collection can.
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All opinions expressed herein are those of the individual authors only and do not necessarily represent the opinions of the NOCCC, its officers, Board of
Directors, the Orange Bytes newsletter or its editors. The NOCCC does not guarantee the accuracy or the correctness of advertising or articles in the
Orange Bytes, nor does the NOCCC intend to endorse, rate, or otherwise officially comment on products available. Therefore, the readers are cautioned
to rely on opinions presented exclusively at their own risk.
Trademarks/Copyrights — The mention of names of products in this publication without trademark or copyright symbols does not imply that they are not so
protected by law. All trademarks are the property of their respective owners.
Production — Formerly: Orange Bytes was produced with Microsoft Word ® using the True Type fonts Arial, Bauhaus 93, Bodoni, and Times New Roman.
Presently: This version uses HTML - older and newer styles merged together.

Please send e-mail address changes to membership@noccc.org

Browser Notes:
1. Getting a printout of the Orange Bytes page:
Screen layout is 900 pixels width for the body (to emulate original PDF layout decisions). This gives adequate presentation on a
monitor set up for 1024px width. However, this is typically too wide for portrait mode on most printers, i.e. some of the image will
be chopped off. So, in Internet Explorer we typically use "Enable Shrink-to-Fit" for most printout purposes. (Other browsers have
a similar feature.) Per the image to the left, this is a
checkbox under
File -> Print -> Page Setup. This allows full page
rendering. HOWEVER, since everything gets shrunk,
the text becomes smaller and harder to read. What to
do? The font size could be made larger to make the
shrunken text look larger. But it would also throw off
the pagination code that is partially present. Solution:
A separate CSS style sheet will be used that just
makes the font size larger for printers. This is a workin-progress. A temporary ALTERNATIVE: Use
Landscape mode and disable shrink-to-fit. (But that
would throw off the portrait-mode pagination code.
Oh well . . . For the present, best to just live with the smaller printout text until the fix comes along.)

Orange Bytes NewsMagazine Past Issues
The Orange Bytes Newsmagazine is available for downloading and viewing with Adobe PDF
readers. Pick the past issue you would like to view from the list below.
Read a brief tutorial below about Navigating In A PDF Document (in PDF format).

May2012 Issue (0.3 megabytes)
April2012 Issue (1.4 megabytes)
March2012 Issue (1.4 megabytes)
February2012 Issue (1.5 megabytes)
January2012 Issue (1.3 megabytes)

December2006 Issue (3,132 Kbytes)
November2006 Issue (4,006 Kbytes)
October2006 Issue (1,878 Kbytes)
September2006 Issue (3,211 Kbytes)
August2006 Issue (2,329 Kbytes)
July2006 Issue (3,726 Kbytes)
June2006 Issue (3,363 Kbytes)
May2006 Issue (2,915 Kbytes)
April2006 Issue (1,639 Kbytes)
March2006 Issue (1,728 Kbytes)
February2006 Issue (1,752 Kbytes)
January2006 Issue (1,834 Kbytes)

December2011 Issue (5.7 megabytes)
November2011 Issue (5.6 megabytes)
October2011 Issue (4.1 megabytes)
September2011 Issue (2.3 megabytes)

December2005 Issue (1,924 Kbytes)
November2005 Issue (1,042 Kbytes)
October2005 Issue (1,100 Kbytes)
September2005 Issue (2,478 Kbytes)
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August2011 Issue (6.2 megabytes)
July2011 Issue (1.8 megabytes)
June2011 Issue (1.6 megabytes)
May2011 Issue (1.7 megabytes)
April2011 Issue (1.5 megabytes)
March2011 Issue (1.0 megabytes)
February2011 Issue (1.4 megabytes)
January2011 Issue (1.9 megabytes)

August2005 Issue (1,022 Kbytes)
July2005 Issue (1,842 Kbytes)
June2005 Issue (1,262 Kbytes)
May2005 Issue (1,500 Kbytes)
April2005 Issue (987 Kbytes)
March2005 Issue (2,084 Kbytes)
February2005 Issue (2,070 Kbytes)
January2005 Issue (1,690 Kbytes)

December2010 Issue (1.8 megabytes)
November2010 Issue (2.0 megabytes)
October2010 Issue (1.2 megabytes)
September2010 Issue (2.3 megabytes)
August2010 Issue (1.2 megabytes)
July2010 Issue (1.6 megabytes)
June2010 Issue (1.4 megabytes)
May2010 Issue (1.3 megabytes)
April2010 Issue (1.8 megabytes)
March2010 Issue (1.4 megabytes)
February2010 Issue (1.2 megabytes)
January2010 Issue (1.1 megabytes)

December2004 Issue (2,449 Kbytes)
November2004 Issue (1,146 Kbytes)
October2004 Issue (1,169 Kbytes)
September2004 Issue (1,185 Kbytes)
August2004 Issue (2,013 Kbytes)
July2004 Issue (1,572 Kbytes)
June2004 Issue (1,289 Kbytes)
May2004 Issue (1,231 Kbytes)
April2004 Issue (1,156 Kbytes)
March2004 Issue (1,384 Kbytes)
February2004 Issue (1,942 Kbytes)
January2004 Issue (1,460 Kbytes)

December2009 Issue (1.2 megabytes)
November2009 Issue (1.3 megabytes)
October2009 Issue (1.1 megabytes)
September2009 Issue (1.2 megabytes)
August2009 Issue (1.3 megabytes)
July2009 Issue (1.7 megabytes)
June2009 Issue (1.2 megabytes)
May2009 Issue (1.1 megabytes)
April2009 Issue (1.0 megabytes)
March2009 Issue (1.3 megabytes)
February2009 Issue (2.3 megabytes)
January2009 Issue (1.1 megabytes)

December2003 Issue (1,492 Kbytes)
November2003 Issue (2404K)
October2003 Issue (1373K)
September2003 Issue (1455K)
August2003 Issue (2187K)
July2003 Issue (11804K)
June2003 Issue (1024K)
May2003 Issue (957K)
April2003 Issue (1050K)
March2003 Issue (668K)
February2003 Issue (1031K)
January2003 Issue (1470K)

December2008 Issue (1.9 megabytes)
November2008 Issue (1.1 megabytes)
October2008 Issue (1.4 megabytes)
September2008 Issue (1.1 megabytes)
August2008 Issue (1.4 megabytes)
July2008 Issue (1.01 megabytes)
June2008 Issue (1.06 megabytes)
May2008 Issue (1.33 megabytes)
April2008 Issue (1.84 megabytes)
March2008 Issue (1.04 megabytes)
February2008 Issue (1.24 megabytes)
January2008 Issue (1.17 megabytes)

December2002 Issue (1064K)
November2002 Issue (1546)
October2002 Issue (1137K)
September2002 Issue (1139K)
August2002 Issue (306K)
July2002 Issue (186K)
June2002 Issue (873K)
May2002 Issue (388K)
April2002 Issue (377K)
March2002 Issue (355K)
February2002 Issue (336K)
January2002 Issue (615K)

December2007 Issue (1.6 megabytes)
November2007 Issue (904 kilobytes)
October2007 Issue (4.6 megabytes)
September2007 Issue (0.913 megabytes)
August2007 Issue (0.931 megabytes)
July2007 Issue (1.998 megabytes)
June2007 Issue (1.91 megabytes)
May2007 Issue (2.23 megabytes)
April2007 Issue (2.19 megabytes)
March2007 Issue (2.27 megabytes)
February2007 Issue (4.81 megabytes)
January2007 Issue (2,154 Kbytes)

End Notes
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Meeting Information — The NOCCC meeting is held at Chapman University, in the Hashinger Science Center and Irvine
Hall, near the corner of N. Center St. and E. Palm Ave., which is in the s outheast corner of the campus.
Parking Information - Chapman University’s main parking lot is the underground Lastinger Parking Structure under Wilson
field on the north side of the campus. Enter from Walnut Avenue, just east of Glassell Street. Parking is not free on Sunday,
even if the gate is up. However, the permit vending machine is about 100 feet south of the entry area. There are other machines
elsewhere in the lot. Find one, buy a permit, and put it on your dashboard. Do not park in any other lot, in a reserved space, or
back into a space.
Free street parking also is available on the campus-side of the streets only. Parking in front of any residential housing will result
in an expensive parking ticket. A City of Orange public parking lot, located on the southwest corner of E. Maple and N.
Orange, is also free and only 2 blocks from the meeting. For more information, see the Transportation Information section.
North Orange County Computer Club
PO Box 3616
Orange, CA 92857
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